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For software training, contact the Computer Training Center (CTC) at 358-1111 or visit the CTC Web 
site at http://itcd.hq.nasa.gov/ctc. 

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc. 
 

Mail 

Within a message dialog box, there are multiple tabs with various commands which display on a ribbon; the features are 
organized in logical groups.  Below are screenshots of the command tabs for Outlook Mail.  

The Outlook Mail folder can be accessed by clicking  or  the Mail icon, or by pressing Ctrl+1.   

Mail Message Command Tabs and Ribbon 

Message Command Tab:  Clipboard, Basic Text, Names, Include, Tags, Zoom and Security 

 

Insert Command Tab:  Include, Tables, Illustrations, Links, Text and Symbols 

 

Options Command Tab:  Themes, Show Fields, Permission, Tracking and More Options 

 

Format Text Command Tab:  Clipboard, Format, Font, Paragraph, Styles and Editing 

 

Review Command Tab:  Proofing and Language 

 

Customize the Quick Access Toolbar for Messages 

As with the Quick Access Toolbars throughout Office 2013, each Outlook new item window has its own Quick Access 
Toolbar that can be customized.  Steps to customize the Quick Access Toolbars throughout Outlook are outlined in the 
Outlook 2013 for Windows QRG 1 – Getting Started.  To learn how to customize views, see the Outlook 2013 for Windows 
QRG 4 – View Customizations. 
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New Messages 

Create a New Message 

1. Click   the Mail icons, or press Ctrl+1 on the Keyboard.   

2. When in the Inbox, click New E-mail on the Home Tab or use the 
shortcut keystroke Ctrl+N to create a new message.  When not displaying 
the Inbox, use the keystroke Ctrl+Shift+M to create a new message.  The 
New E-mail Message dialog box displays (shown right). 

3. To search for the addressee:  

Click Options Tab | Bcc to enable the Bcc field.    

 

a. Click To, Cc or Bcc (if enabled).  The Select Names dialog box displays.   

b. Type a search term in the field provided and click to select the appropriate name(s) from the search result. 

c. Click To, Cc, or Bcc to display the selected names in the appropriate field.  Click OK.   

1. Enter the Subject Line text and Message Body text.   

2. Use the features on the Message Command Tabs (discussed in the section entitled Message Window Command Tabs   
at page 2) to insert items, format text, mark private or spellcheck. 

3. Click Send or press CTRL+ENTER . 

Message Window Command Tabs 

Message Command Tab:  Clipboard, Basic Text, Names, Include, Tags, Zoom and Security 

 

 Click the Clipboard, Basic Text, Tags or Security dialog box launchers (shown above with rectangle graphics) 
to display the full dialog boxes for each set of commands. 

 Select text and then click any of the buttons to apply changes:  Cut, Copy, Text font tools and paragraph 
alignment, indent and spacing tools. 

 Click Paste to insert cut or copied text. 

 Select the text with the desired formatting then click Format Painter to copy the format one time from the 
selected text and paint the same format over newly selected text.  Click the Format Painter twice to turn on the 
feature and paint formatting over selected text multiple times.  Click Format Painter once to turn it off. 

 Click Check Names to search for the addressee and validate the e-mail address. 

 Click Attach File to include a file in the message. 

 Click Attach Item to include any Outlook item type (i.e., a Contact Card, Task, etc.). 

 Click Signature to insert your signature.  For more information on creating signatures, see the section entitled 
Signatures at page 6. 

 Click Follow Up to flag the item, High Importance to set the importance level to high or click Low Importance 
to set the importance level to low.   

 Click Encrypt to encrypt the message using your PKI certificate. 

Insert Command Tab:  Include, Tables, Illustrations, Links, Text and Symbols 

 

 Click Attach File to include a file in the message. 
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 Click Outlook Item to include any item type from Outlook (i.e., a Contact Card, Task, etc.). 

 Click Calendar to send a Calendar via e-mail. 

 Click Signature to insert your signature.  For more information on creating signatures, see the section entitled 
Signatures at page 6. 

 Click Table to insert a table with full Word 2013 Table functionality.  The Table Tools Design and Layout 
Command Tabs display.  

 Click any of the Illustrations, Links, Text, or Symbols commands to insert the appropriate item. 

Options Command Tab:  Themes, Show Fields, Permission, Tracking and More Options 

 

 Click Themes, Colors, Fonts, Effects and Page Color to change the message design, not the inserted content in 
the message. 

 Click Bcc to show the Bcc field. 

 Click the checkboxes to select Request a Delivery Receipt and/or Request a Read Receipt.   

 Click Save Sent Item To and specify a folder to direct the sent item to, other than the Sent Items folder.   

 Click Delay Delivery to set a specific delivery date and time. 

 Click Direct Replies To and select the appropriate person to receive the e-mail message responses. 

 Click the More Options dialog box launcher for additional options such as setting an expiration date. 

Format Text Command Tab:  Clipboard, Font, Paragraph, Styles and Editing 

 

 Click the Clipboard, Font, Paragraph or Style dialog box launchers (shown above with rectangle graphics) to 
display the full dialog boxes for each set of commands. 

 Click HTML, Plain Text or Rich Text to set the text format for the E-mail message. 

 Select text and then click any of the buttons to apply changes:  Cut, Copy, text Font tools and Paragraph 
alignment, indent borders, sorting and spacing tools. 

 Click Paste to insert cut or copied text. 

 Select the text with the desired formatting then click Format Painter to copy the format one time from the 
selected text and paint the same format over newly selected text.  Click the Format Painter twice to turn on the 
feature and paint formatting over selected text multiple times.  Click Format Painter once to turn it off. 

Review Command Tab:  Proofing and Language 

 

 Click Spelling & Grammar to check the spelling or grammar of the message. 

 Click Research to enable the Research Task Pane with fields to search reference materials and online. 

 Select text and click Thesaurus to find a synonym of the selected word. 

Create Voting Buttons 

On the Options Tab you can build a custom command with voting buttons that the recipient uses to reply to your 
message.  Voting buttons also provide response tracking.  
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1. From the Options Tab, click Use Voting Buttons.   A drop-
down list displays with pre-defined voting button options.  To 
create unique text on the buttons, click Custom.  The Properties 
dialog box displays (partial screenshot shown right).  

2. In the Voting and Tracking options, click the Use voting 
buttons checkbox to enable.   

 

3. Type the text for each button in the field provided and separate each button text with a semi-colon (;).  

4. Click OK.  In your message a note displays stating “You have added voting buttons to this message.”  The buttons 
display in the Sent Item. 

To review the responses, open your Sent message and click Tracking in the Show command group. 

Respond via Voting Buttons 

The recipient’s message will have a Vote button on the Message Tab.  The recipient 
clicks Vote and then clicks to select their vote from the drop-down list of possible 
choices. 

 

Work with Message Options from Open Item 

 

Double-click on a message in your Inbox or mail subfolder to open a message.  The message displays with the Message 
Command Tab ribbon forward (shown above). 

 Use the features on the ribbon to Ignore, Delete, or Junk the e-mail. 

 Click Reply, Reply All, or Forward to draft a response.   

 Click Meeting to create a meeting from the message.  The message text will be inserted in the meeting. 

 Click the More drop-down arrow to select the command Forward as Attachment. 

 Use Quick Steps to run pre-defined rules in the Outlook software to make certain tasks 
faster.  Creating rules is outlined in the section entitled Quick Steps at page 7. 

 Click Move to move or copy the message to a selected folder. 

 Click Mark Unread to change the message status to Unread. 

Work with E-Mail Messages (from the Inbox or Subfolder) 

1. Click to select the message(s) you want to affect and right-click to display a Shortcut Menu. 

2. From the Shortcut Menu you can do any of the following:   

 Copy, Quick Print, Reply, Reply All, Forward, or Mark as Unread.  

 Assign a Category, or flag for Follow Up.  For instructions on working with Categories see 
the section entitled Click to select the checkbox for Flag for Recipients. 

a. In the Flag to field, click the drop-down arrow and select from the list or type your own text 
in the field. 

b. Click the Reminder checkbox to enable the reminder and enter in the provided fields a date 
and time to be reminded.  Click OK twice.  

 Categories at page 5.  For instructions on working with Flags see the section entitled Follow 
Up Flags at page 5. 

 Click Find Related to search for Messages in This Conversation or Messages from Sender. 

 Use Quick Steps for faster processing by building a Rule.  For instructions on creating 
Quick Steps see the section entitled Quick Steps at page 7. 

 Click Move to move to a specific folder. 

 Click Ignore, Junk, or Delete as appropriate for the selected message(s). 

 Click Secure to encrypt the message(s). 
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Follow Up Flags 

You can apply a Follow Up Flag to any Outlook item, thereby creating a To-Do item with a notification reminder. 

1. Click Follow Up to flag a message.   

2. From the Follow Up drop-down list, click one of the pre-defined follow up 
options, or click Custom to create a To-Do item with a reminder.  The Custom 
dialog box displays (shown right).   

3. Click to select the checkbox for Flag for Me. 

a. In the Flag to field, click the drop-down arrow and select from the list 
or type your own text in the field. 

b. Enter a Start date and Due date. 

c. Click the Reminder checkbox to enable the reminder and enter in the 
provided fields a date and time to be reminded.  Click OK.   

4. Click to select the checkbox for Flag for Recipients. 

a. In the Flag to field, click the drop-down arrow and select from the list or type your own text in the field. 

b. Click the Reminder checkbox to enable the reminder and enter in the provided fields a date and time to be 
reminded.  Click OK twice.  

Categories  

Categories are a great way to stay organized and can be applied to any Outlook item type.  Categories cannot be applied to 
folders or subfolders however.  After categorizing items, you can later search by the category.   

Create a Category 

1. From the Home Tab for Mail, Contacts or Tasks folder, click Categorize | All 
Categories.  The Color Categories dialog box displays (shown bottom right).   

2. Click New.  The Add New Category dialog box displays (shown right).  

3. Type a descriptive name in the Name field.  

4. Click the Color drop-down arrow and select a color from the list.  

5. Click the Shortcut Key drop-down arrow and select a keystroke combination from the pre-defined list. 

6. Click OK to save the new category. 

Whenever you create a new category from within an item, Outlook enables the new category for that item. 

Categorize within a new message   

1. In the message, click Options | More Options Dialog Box Launcher (shown right).   The Options 
dialog box displays (partial screenshot shown below).  

2. Click Categories.  A list of your Categories displays.   

3. Click to select the desired Category and click Close. 

Categorize Items in a Main Folder or Subfolder  

1. Select the message, task, contact card, or appointment to be categorized. 

2. Right-click and then click Categorize.  The list of your categories displays.  

3. Click the desired category to apply it to the item.  

Categorize Items using the Color Categories Dialog Box 

The list is limited to 15, so if you do not see the category you would like, do the 
following: 

1. Click All Categories.  The Color Categories dialog box displays the full list 
of your categories (shown right).   

2. Click the checkbox to select the desired category.  You can apply more 
than one category to any item. 

3. Click OK. 
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Edit a Category 

1. Click the Home Tab | Categorize | All Categories.  The Color Categories dialog box displays (shown above).   

2. Click to select the category and click Rename, Delete or click the Color drop-down arrow and select a different color.   

3. If you delete a category that is applied to existing Outlook items, the category will remain applied to the item but will 
not display in your category list. 

Search Tools  

Run a Basic Search 

The basic Search tool is available regardless of the Outlook folder displayed at the time.  This search tool allows you to 
search with a single criterion in the displayed folder. 

1. Display the folder to be searched and click into the Search box (shown right) 
or press the shortcut keystroke Ctrl + E.  The Search Tools Tab displays.    

2. Type the search criteria in the Search box and press ENTER.  The search 
runs on the displayed folder and displays the search result. 

 

The Search Tools Tab (shown right) only displays 
when searching.  For more information on the 
Search Tools Tab and Advanced Search, see Outlook 
2013 for Windows QRG 9 – Search Tools.  

Signatures 
Use the Signature options to automatically include a signature in messages.  You can have more than one signature stored 
so you can select to use one for new e-mail messages and another one for replies and forwarded messages. 

1. From the e-mail message, click Insert | Signature | Signature.  The 
Signatures and Stationery dialog box displays (shown right). 

2. Click New to create a signature.  The New Signature dialog box displays. 

3. Type a name for the signature in the field provided and click OK.  Your 
screen will return to the Signatures and Stationery dialog box. 

4. Enter the text for the signature in the Edit Signature text field.   

5. Use the editing buttons to change the font or alignment. 

6. Select the signature to use for your e-mail account for New messages and 
Replies/forwards. Click OK. 

 

Out of Office Assistant 

1. Click the File Tab | Automatic Replies.  The Automatic Replies dialog box 
displays (shown right). 

2. Click to select Send automatic replies. 

You can also select Only send during this time range and enter a start date and time 
along with an end date and time. 

3. Click the Inside My Organization Tab to create a message for internal NASA 
e-mail addresses. 

4. Click the Outside My Organization Tab to create a message for external 
non-NASA e-mail addresses. 

a. To use the Outside My Organization Out of Office reply, click the 
checkbox for Auto-reply to people outside my organization. 

b. Click to select either My Contacts only or Anyone outside my 
organization. 

5. Click the Font drop-down arrow to select the desired font.  
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6. Type the Out Of Office reply in the text fields provided on both the Inside My Organization and Outside My 
Organization Tabs.  

7. Click the Point size drop-down arrow to select the size of the font. 

8. Use the editing buttons on the toolbar to apply font and paragraph attributes to the text entered into the text field. 

9. Click OK.   

Quick Steps 

Quick Steps are rules that automate user-defined actions to assist with faster processing. 

Create a Quick Step 

1. Highlight the message to which you will apply the rule.  

2. From the main Outlook view, click the Quick Steps dialog box 
launcher (shown upper right).   

The Manage Quick Steps dialog box displays (shown lower right).   

In the Quick Step list are pre-defined Quick Steps and those created by 
the user.  To the right is the Description of the selected Quick Step. 

3. METHOD 1:  to create a Quick Step using the pre-defined 
actions:  

a. Click New in the Manage Quick Steps dialog box.   A drop-down 
list displays with pre-defined actions to include:  Move to 
Folder, Categorize and Move, Flag and Move, New e-mail 
to, Forward to, New meeting with or Custom.  

For this example, we will create a Move to Folder Quick Step.   

b. Select one of the pre-defined actions.  For this example, click 
Move to Folder.  The First Time Setup dialog box displays 
(shown right). 

c. Type a name for the Quick Step in the Name field. 

d. Click the Move to folder drop-down arrow and select the 
desired folder from the list or browse to select the folder by 
clicking Other Folder.   

e. Click Finish.  The new Quick Step will display in the Quick 
Step list in the Manage Quick Steps window. 

4. METHOD 2:  to create a custom Quick Step: 

a. From the Quick Step group on the Home Tab, click Create 
New.   The Edit Quick Step dialog box displays (shown right). 

b. Type a name for the Quick Step in the Name field.  

For this example, we will create a rule that attaches the e-mail to a task 
and then deletes the messages from the folder.   

c. Click the Actions drop down arrow and select the desired 
action from the list.   For this example, select Create a task 
with attachment. 

d. Click Add Action.  A second Action drop-down field displays. 

e. Click the drop-down arrow and select the second action to be 
performed.   For this example, click Delete message. 

f. Click Finish.  The new Quick Step will display in the Quick 
Step list in the Manage Quick Steps window. 

Apply a Quick Step 

In the main Outlook view, select the desired message, and click the 
specific Quick Step from the Quick Step group on the Home Tab. 
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Outlook Mail Folders  

It is recommended that all folders be nested under the Inbox.  This way you can collapse the inbox and decrease the 
overall size of the All Mail Folders display.   

Create Folders Delete Folders 

1. In the Folder List in the Navigation, 
select the Inbox folder, right click and 
select New Folder from the shortcut 
menu.  The new folder displays below 
the selected folder with the cursor in 
the name box (shown right). 

2. In the Name box, enter a name for the 
new folder. 

3. Press ENTER on the keyboard. 

 

1. Select the folder from the Folder list in the 
Navigation. 

4. Right-click on the folder and select Delete 
Folder from the shortcut menu.  The 
Verification dialog box will appear. 

5. Select Yes to confirm the deletion.  The 
folder will be removed. 

Once a folder is deleted, all of its contents are also 
deleted. 

Deleted Items Tools 

Automatically Empty Deleted Items 

1. Click File | Options | Advanced.  The Outlook Advanced 
Setting options display. 

2. In the Outlook start and exit section (shown right), select 
Empty Deleted Items folders when exiting Outlook.    

3. Click OK.  

You can also permanently delete items by pressing SHIFT + DELETE and Outlook will permanently delete the item without 
placing it in the Deleted Items folder at all. 

Recoverable Items 
If you delete an item and need to restore it to your mailbox, it is available in the Recover Deleted Items list for two for a 
period of two weeks after the deletion date. 

Display the Recover Deleted Items Folder 

 Click Folder | Recover Deleted Items.  The Recover Deleted Items 
window displays (shown right). 

 Select items to be recovered.  Multi-select by pressing Shift+click for 
contiguous items or Ctrl+click for non-contiguous items. 

You can also click Select All.   

 Click Recover Selected Items to restore the messages to your Deleted 

Items folder.   

Clicking Delete  in the Recover Deleted Items Folder will permanently 
delete the item from the Outlook server. 

 

Mail Options  

To access Mail Options, click File | Options | Mail.   

The Outlook 2013 text editor is Word 2013.   

Many of the mail options are set by the Outlook Exchange Administrators and should not be changed.  Below is a select 
list of features you may want to change to adjust Outlook behavior. 

Mail Option:  Compose messages 

 Click the Compose messages in this format drop-down arrow and select HTML, Rich Text, or Plain Text as 
the message format.  HTML is selected by default. 

 Enable/disable Always check spelling before sending by clicking the checkbox. 
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 Enable/disable Ignore original message text in reply or forward by clicking the checkbox. 

 Click Spelling and Autocorrect to access the Proofing and Advanced Options (see the section entitled 
AutoCorrect and AutoFormat Options at page 11).   

 Click Signatures to create or modify signatures for messages.  Signatures are discussed in more detail in the 
section entitled “Signatures” at page 6.  

 Click Editor Options to make the following edits:   

o Click Proofing (the left side of the window) to adjust AutoCorrect options and Spell Check options.  Use 
AutoCorrect and AutoFormat to replace text as you type, turn on features that automatically replace certain 
text, and define how automatic numbering and bullets are applied. 

o Click AutoCorrect Options to adjust the AutoCorrect, Math AutoCorrect, AutoFormat as you Type and 
AutoFormat customizations.  For more information on AutoCorrect and AutoFormat features, see sections 
entitled “Work with AutoCorrect” and “Work with AutoFormat” at page 11.   

o Click Advanced (the left side of the window) to adjust Editing options, Cut, copy, and paste, and Display 
settings. 

o Click OK to close the Editor Options dialog box.  

Mail Options:  Outlook panes 

Click Reading Pane to customize how items are marked as read when viewed in the Reading Pane.   

Reading Pane Options 

1. In Outlook panes, click Reading Pane.  The Reading Pane dialog box displays 
(shown right). 

 Select the checkbox for Mark items as read when viewed in the Reading 
Pane if desired. 

 Enter a value in the Wait [  ] seconds before marking item as read. 
 

 Select the checkbox for Mark item as read when selection changes if desired. 

 Select the checkbox for Single key reading using space bar if desired.   

2. Click OK. 

Mail Options:  Message arrival 

1. Select the behavior when new messages arrive to: 

 Play a sound; 

 Briefly change the mouse pointer; 

 Show an envelope icon in the taskbar; or 

 Display a Desktop Alert. 

2. Click Desktop Alert Settings to set the Duration and Transparency of the Alert box. 

Mail Options: Conversation Clean Up 

Select the behavior when using the Conversation Clean Up tools.  These options are discussed in detail in the Outlook 
2013 QRG 5 – Clean Up Tools.    

Mail Options:  Replies and forward 

 Enable/disable Open replies and forwards in a new window by clicking the checkbox. 

 Enable/disable Close original message window when replying or forwarding by clicking the checkbox; 

 Enable/disable Preface comments with [User name] by clicking the checkbox; 

 Click the drop-down arrow to select Outlook behavior When replying to a message. 

 Click the drop-down arrow to select Outlook behavior When forwarding a message. 

Mail Options:  Save messages 

1. To automatically backup messages as they are being drafted, enable Automatically save items that have not been 
sent after this many minutes [ ].  Enter a value in the field provided. 

2. For the Save to this folder options, click the drop-down arrow and select the folder for the messages to be saved in.  
By default, the selection folder is the Draft folder. 
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 You can save replies to moved messages in the same folder by enabling When replying to a message that is not 
in the Inbox, save the reply in the same folder. 

 Enable/disable Save forwarded messages by clicking the checkbox. 

 Enable/disable Save copies of messages in the Sent Items folder by clicking the checkbox. 

 Enable/disable Use Unicode format by clicking the checkbox. 

Mail Options:  Send messages 

 Click the drop-down arrow for the Default Importance level to select from options Low, Normal or High.  
Changing this setting does not change the delivery of the message.  It is merely an indicator for the recipient. 

 Click the drop-down arrow for Default Sensitivity level and select from options Normal, Personal, Private, or 
Confidential.  Private settings blocks the user’s delegate from seeing the message in the delegator’s inbox. 

 Enable the option Mark messages as expired after this many days: [  ] to mark expired unread messages in 
the recipient’s mailbox after a specified length of time.  Enter the number of days as appropriate. 

 Enable Commas can be used to separate multiple message recipients to use the comma in addition to the 
semi-colon to separate addressees when creating messages. 

 Enable Automatic name checking to have Outlook look up the keyword typed into the To: From: Cc: or Bcc: 
fields in a message.  This option is enabled by default. 

 Enable Delete meeting requests and notification from Inbox after responding to have Outlook automatically 
remove those notices.  This setting is enabled by default. 

 Enable CTRL + ENTER sends a message to use the keystroke combination CTRL + ENTER to send the message 
after drafting.  This option is enabled by default. 

 Enable Use Auto-Complete List to suggest names when typing in the To, Cc, and Bcc lines to have Outlook 
refer to a list of names frequently communicated with when resolving names while addressing a message. 

 Click the Empty Auto-Complete List to discard the current list of names and start the list with new entries. 

Mail Options:  Tracking 

 Enable Delivery receipt confirming this message was delivered to the recipient’s e-mail server to receive a 
delivery receipt when sending message.  Not all e-mail servers support this feature. 

 Enable Read receipt confirming the recipient viewed the message to receive a read receipt when sending 
messages.  Not all e-mail server support this feature. 

 To control Outlook behavior when messages are received with read receipt request enabled, select: Always, 
send a read receipt, Never send a read receipt, or Ask each time whether to send a read receipt. 

 Enable Automatically process meeting requests and responses to meeting requests and polls for Outlook 
to update calendar entries when processed through the calendar invite message.  This is set by default. 

 Enable Automatically update original sent item with receipt information to track delivery and read receipts 
for message recipients. 

 Enable Update tracking information, and then delete responses that don’t contain comments to update 
tracking and delete e-mail responses without a note from the recipient. 

 Enable After updating tracking information, move receipt to if you wish to save the receipts in a folder.  
Select the move to folder location in the field provided.  Click Browse to locate the folder. 

Mail Options:  Message Format  

Do not change these options.  They have been set by the Outlook Exchange Administrators appropriately for the NASA 
network environment.   

Mail Options:  Other 

 Enable/disable Show Paste Options button when content is pasted into a message.  This 
option enables the Paste Option displayed to the right to automatically display when pasting 
content into a message.  

 Enable/disable Show Next and Previous links in the message headers when reading messages. 

 Select a behavior After moving or deleting an open item by clicking the drop-down arrow and select:  open 
the previous item, open the next item, or return to the current folder. 
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AutoCorrect and AutoFormat Options 

AutoCorrect and AutoFormat allow the typist to use automatic formatting while typing.  Many of the features are enabled 
by default but can be turned off or overwritten at the time text is entered. 

Work with AutoCorrect 

1. Click the File Tab | Options | Mail | Spelling and AutoCorrect | AutoCorrect options.  The AutoCorrect dialog box 
displays (shown below).  

Included in the AutoCorrect dialog box are features to set up automatic formatting for AutoFormat, AutoFormat as You 
Type, Math AutoCorrect, and AutoCorrect. 

2. From the AutoCorrect Tab enable/disable any of the following options: 

 Show AutoCorrect Options button. 

 Correct TWo INitial CApitals. 

 Capitalize first letter of sentences. 

 Capitalize first letter of table cells. 

 Capitalize names of days. 

 Correct accidental use of cAPS LOCK key. 

 Replace text as you type. 

 To add a new entry, click into the Replace field and type the word to be 
used as shorthand for another entry.  Click into the With field and type 
the word(s) to be inserted.  Click Add.  

 To delete an entry, click on the entry in the list and click Delete. 

3. Click OK when done. 
 

Work with AutoFormat 

Many of the same features on the AutoFormat Tab are also on the AutoFormat As You Type Tab. 

1. Click the File Tab | Options | Mail | Spelling and AutoCorrect | 
AutoFormat Tab.  The AutoFormat dialog box displays (shown right). 

2. From the AutoFormat Tab enable/disable any of the following options: 

 Apply Built-In Heading styles. 

 Apply List styles. 

 Apply Automatic bulleted lists. 

 Apply Other paragraph styles. 

 Replace ʺStraight quotesʺ with “smart quotes.” 

 Replace Ordinals (1st) with superscript. 

 Replace Hyphens (--) with dash(—) 

 Replace *Bold* and _italic_ with real formatting. 

 Replace Internet and network paths with hyperlinks. 
 

3. Click OK when done. 

4. Additional options are available on the AutoFormat As You Type Tab 
(partial screenshot shown right) to include:   

 Format beginning of list item like the one before it,  

 Set left- and first-indent with tabs and backspaces, and  

 Define styles based on your formatting. 
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Mail Shortcut Keystrokes 

To Do This Press To Do This Press 

Switch to Inbox. CTRL+SHIFT+I Delete and Ignore a Conversation. CTRL+DELETE 

Switch to Outbox. CTRL+SHIFT+O Open the Address Book. CTRL+SHIFT+B 

Choose the account from which to send 
a message. 

CTRL+TAB (with the focus  
on the To box), and then  
TAB to the Accounts button 

Add a Quick Flag to an unopened 
message. 

INSERT 

Check names. CTRL+K Display the Flag for Follow Up 
dialog box. 

CTRL+SHIFT+G 

Send. ALT+S Mark as read. CTRL+Q 

Reply to a message CTRL+R Mark as unread. CTRL+U 

Reply all to a message CTRL+SHIFT+R Open the Mail Tip in the selected 
message. 

CTRL+SHIFT+W 

Reply with meeting request CTRL+ALT+R Find or replace. F4 

Forward a message CTRL+F Find next. SHIFT+F4 

Mark a message as not junk CTRL+ ALT+J Send. CTRL+ENTER 

Display blocked external content (in a 
message) 

CTRL+SHIFT+I Print. CTRL+P 

Post to a folder CTRL+ SHIFT+S Forward. CTRL+F 

Apply Normal style CTRL+SHIFT+N Forward as attachment. CTRL+ALT+F 

Check for new messages CTRL+M or F9 Show the properties for the 
selected item. 

ALT+ENTER 

Go to the previous message UP ARROW Create a multimedia message CTRL+SHIFT+U 

Go to the next message DOWN ARROW Create a text message. CTRL+SHIFT+T 

Create a message (when in Mail) CTRL+N Mark for Download. CTRL+ALT+M 

Create a message (from any Outlook 
view) 

CTRL+SHIFT+M Clear Mark for Download. CTRL+ALT+U 

Open a received message CTRL+O Display Send/Receive progress. CTRL+B (when a Send/Receive 
is in progress) 

 


